
 
 

BigFix Development 
Environment™ (BDE) 

 
A Guide to Creating  

Fixlet® Sites and Messages  
 

 
 
 

BigFix, Inc. 
Emeryville, CA 

 
 
 
 
 

Last Modified: March 7, 2003 
Version 2.0 



BigFix Development Environment Page ii 
 March 7, 2003 

 © 2003 by BigFix, Inc. 
   

 
 
 
 

© 1998–2003 BigFix, Inc. All rights reserved. 
 
BigFix®, Fixlet® and "Fix it before it fails"® are registered trademarks of 
BigFix, Inc. i-prevention, Powered by BigFix, Relevance Engine, and 
related BigFix logos are trademarks of BigFix, Inc. All other product 
names, trade names, trademarks, and logos used in this documentation are 
the property of their respective owners. BigFix’s use of any other 
company’s trademarks, trade names, product names and logos or images of 
the same does not necessarily constitute: (1) an endorsement by such 
company of BigFix and its products, and (2) an  endorsement of the 
company or its products by BigFix. 
 
No part of this documentation may be reproduced, transmitted, or 
otherwise distributed in any form or by any means (electronic or 
otherwise) without the prior written consent of BigFix, Inc. You may not 
use this documentation for any purpose except in connection with your use 
or evaluation of BigFix software and any other use, including for reverse 
engineering such software or creating compatible software, is prohibited. 
If the license to the software which this documentation accompanies is 
terminated, you must immediately return this documentation to BigFix, 
Inc. and destroy all copies you may have. 
 
All inquiries regarding the foregoing should be addressed to: 
 

BigFix, Inc. 
5915 Hollis Street 

Emeryville, CA 94608-2017 
 

 
 
 
 
 
 
 
 
 
 
 
 



BigFix Development Environment Page iii 
 March 7, 2003 

 © 2003 by BigFix, Inc. 
   

Contents 

Preface 1 

Audience........................................................................................................................1 
Organization of this Guide .............................................................................................1 
Conventions Used in this Guide ....................................................................................2 

BDE Introduction 3 

Launching the BDE........................................................................................................3 
BDE Overview ...............................................................................................................5 

BDE Menus 6 

The File Menu................................................................................................................6 
The Edit Menu ...............................................................................................................6 
The View Menu..............................................................................................................7 
The Content Menu.........................................................................................................8 
The Tools Menu.............................................................................................................9 
The Window Menu.........................................................................................................9 
The Help Menu............................................................................................................10 

Sites 11 

Introduction..................................................................................................................11 
Using the Site Tree......................................................................................................12 
Setting Preferences for the Site Tree...........................................................................15 
Creating a Fixlet Site ...................................................................................................16 
Importing a Fixlet Site..................................................................................................17 
Exporting a Fixlet Site to XML .....................................................................................18 
Importing an XML File..................................................................................................18 
Deleting a Fixlet Site....................................................................................................19 

Digests 20 

Overview......................................................................................................................20 
Creating a Digest.........................................................................................................21 
Adding Relevance to a Digest .....................................................................................22 
Setting the Delay on a Digest ......................................................................................23 
Saving a Digest ...........................................................................................................23 



BigFix Development Environment Page iv 
 March 7, 2003 

 © 2003 by BigFix, Inc. 
   

Renaming a Digest ......................................................................................................24 
Moving or Copying a Digest.........................................................................................25 
Deleting a Digest .........................................................................................................25 
Restoring a Deleted Digest..........................................................................................25 

Templates 26 

Introducing Fixlet Templates........................................................................................26 
Naming Template Fields..............................................................................................28 
Customizing a Fixlet Template ....................................................................................29 
Inserting Template Fields ............................................................................................30 
Deleting a Fixlet Template...........................................................................................30 

Fixlet messages 31 

Creating Fixlet Messages ............................................................................................31 
Defining Relevance Clauses........................................................................................33 
Evaluating Relevance Clauses ....................................................................................34 
Creating the Fixlet Body ..............................................................................................35 
Renaming the Fixlet Message .....................................................................................36 
Modifying the Fixlet Description...................................................................................37 
Adding HTML Tags......................................................................................................38 
Editing HTML Tags......................................................................................................38 
Adding Images.............................................................................................................39 
Modifying Images ........................................................................................................40 
Adding Tables..............................................................................................................40 
Modifying Tables .........................................................................................................40 
Applying Styles ............................................................................................................41 
Saving a Fixlet Message..............................................................................................42 
Moving/Copying a Fixlet Message...............................................................................43 
Deleting a Fixlet Message ...........................................................................................43 
Restoring a Deleted Fixlet Message............................................................................44 
Finding Text within a Fixlet Message...........................................................................45 
Finding Objects............................................................................................................46 
Using the Output List ...................................................................................................47 
Viewing the Version History.........................................................................................48 

Action Buttons 49 

Creating Action Buttons...............................................................................................49 
Modifying an Existing Action Button ............................................................................51 
Deleting an Action Button ............................................................................................52 

Other Fixlet Fields 54 



BigFix Development Environment Page v 
PREFACE March 7, 2003 

 © 2003 by BigFix, Inc. 
   

Adding Developer-Defined Fields ................................................................................54 
Displaying Developer-Defined Fields...........................................................................55 
Defining Keywords and Header Fields.........................................................................55 
Deleting a Developer-Defined Field.............................................................................56 

Propagation 57 

The Approval Process .................................................................................................57 
Approving a Site Element ............................................................................................58 
Approving Multiple Site Elements ................................................................................59 
Viewing Approval History.............................................................................................61 
Propagating a Fixlet Site..............................................................................................62 

Index 65 

 

 



BigFix Development Environment Page 1 
PREFACE March 7, 2003 

 © 2003 by BigFix, Inc. 
   

Preface 

This guide to the BigFix® Development Environment (BDE) uses simple step-by-step 
instructions to demonstrate the creation of Fixlet® messages. With this guide -- and some 
help from the Windows Inspector Library and the Fixlet Action Commands -- you will be 
able to create Fixlet Messages that can identify and correct problems on targeted computers 
and across extended networks. 

AAuuddiieennccee  

This guide is for people who want to author Fixlet messages for an internal network or for 
public distribution. Fixlet authors may be administrators of large computer networks, 
requiring a managed roll-out of software patches, or they may be hardware or software 
vendors, wishing to support their products in the field with regular updates. To get the most 
out of this guide, it helps to have some experience in the following: 

• BigFix Relevance Language 

• BigFix Windows Inspectors 

• BigFix Action Commands 

OOrrggaanniizzaattiioonn  ooff  tthhiiss  GGuuiiddee  

• BigFix Development Environment Overview: Introduces the BigFix Development 
Environment and explains how to navigate in the BDE. 

• Site Development: Shows how to create a Fixlet site to serve up Fixlet digests and 
messages. 

• Digest Development: Shows how to group Fixlet messages into digests. 

• Template Develoment: Shows how to create HTML templates for your Fixlet 
messages. These speed development and provide a consistent look to your Fixlet site. 

• Fixlet message Development: Shows how to create a Fixlet message that will target 
only the computers affected by a given issue. 

• Action Buttons: Shows how to insert actions into Fixlet messages to fix the problem. 

• Other Fields: Shows how to insert special developer-defined fields to relate back to a 
knowledge base or other sources of information. 

• Propagating Fixlet messages: Explains how to move the Development Fixlet 
messages to a Fixlet server for testing or deployment. 



BigFix Development Environment Page 2 
PREFACE March 7, 2003 

 © 2003 by BigFix, Inc. 
   

CCoonnvveennttiioonnss  UUsseedd  iinn  tthhiiss  GGuuiiddee  

This document makes use of the following conventions and nomenclature: 

Convention Use 
Mono-space A mono-spaced font is used to indicate the contents of a Fixlet File. 

It can refer to MIME, HTML or expressions in the Relevance 
Language. 

Bold Italics Bold Italics are used for the titles of manuals and other cited 
literature.  

[brackets] Brackets are used to indicate optional items in an expression. For 
instance, [of (reference expression)] means that an of statement may 
be included in the expression at your option. 

 

Code Examples: 
Square bullets denote examples of relevance expressions, action scripts, HTML or other 
code. If you have a color version of this file, these square bullets are also red: 

��  exists folder “fonts” of folder “c:\windows”  

 

Common Terms: 
Agent: This is the BigFix end-user program running on a node in a network or BigFix 
Enterprise deployment. 
User, Subscriber or Client: The person using the BigFix agent. A typical user may have 
several Fixlet site subscriptions in addition to yours. 
Author: The author is the person creating Fixlet messages and posting them to a Fixlet site. 
If you're reading this document so that you can write your own Fixlet messages, this refers 
to you. 

BDE Administrator: The person in charge of deploying and maintaining the BigFix 
Development Environment, including the Fixlet database. This person is often the same as 
the author, but may also be a network administrator. The administrator will provide 
authorization levels to the various Fixlet authors. 
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BDE Introduction 

LLaauunncchhiinngg  tthhee  BBDDEE  

The BigFix Development Environment is designed to interface with a Database 
Management System (DBMS). A default database, local_bde.mdb, is supplied to get you 
started.  

Typically, the BDE administrator will create a database and an ODBC data source to access 
it. When you launch the BigFix Development Environment, you then select which database 
to use. 

11  Launch the BDE program. Depending on your desktop configuration you can launch 
the BDE from Start / Programs / BigFix Development Environment or from the 
desktop icon.  
 

 
22  When the Connect to Database dialog appears, select the name of the database you 

want to use and enter the DBMS username and password (if any). Select local to use 
the supplied default database -- in which case no user name or password is required. 
 

 
 

33  Click OK to continue loading the BigFix Development Environment. 
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44  If the login is successful, the BigFix Development Environment will appear. The exact 
appearance of this screen will differ depending on what views were open when the 
product was last closed. 
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BBDDEE  OOvveerrvviieeww  

The BigFix Development environment is an Integrated Development Environment that 
should be immediately familiar and comfortable to most users. The interface includes a 
menu bar, a tool bar, and various panes to display data. 
 

 

Site Tree A hierarchical display of the Fixlet site, including its Fixlet 
messages, digests and associated folders. Use the site tree to display 
an individual Fixlet message. The site tree is a detachable dialog. 

Document 
Area 

Displays the body of a Fixlet message or template. The body is 
typically an HTML document, and this is where you can create and 
edit it. There are three tabs at the bottom of the display area that let 
you edit the HTML, view the HTML or view the source. 

Field Section Displays the relevance clauses, the actions and the other fields 
associated with the currently displayed Fixlet message or digest.  

Output List Displays the results of the “Find Objects” option from the Edit 
menu. The output list is a detachable dialog. 
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BDE Menus 

TThhee  FFiillee  MMeennuu  

The File Menu lets you deal with the various files and databases that make up a Fixlet site. 
It offers the following commands: 
 

Save Ctrl+S Save the current set of Fixlet messages and 
digests. 

Import from 
XML… 

Imports an XML document which may contain 
Fixlet messages, Digests, Templates or other 
files. 

Connect... Connect to the Fixlet database. 

Disconnect Disconnect from the current Fixlet database. 

Preferences... Set various database, propagation and program 
preferences. 

Exit Exit the BDE program 

 

TThhee  EEddiitt  MMeennuu  

The Edit Menu has the traditional clipboard commands for manipulating and finding text 
and other objects. It offers the following commands: 

 

Cut Ctrl+X Cut text and put in clipboard. 

Copy Ctrl+C Copy text and put in clipboard. 

Paste Ctrl+V Insert the contents of the clipboard at the current cursor 
position. 

Clear  Clears the contents of the clipboard. 

Find Objects… Brings up a dialog to find text in various Fixlet 
fields. You must be connected to a database 
before you can select Find Objects. 
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TThhee  VViieeww  MMeennuu  

The View menu allows you to select which of the BDE windows you want to display and 
how you want to display them. It offers the following commands: 

 

√ Site Tree Toggle the Site Tree panel. 

√ Output List Toggle the Fixlet Output List panel. 

√ Toolbar Toggle the Toolbar display containing the tool icons. 

√ Status Bar Toggle the Status Bar display. 

HTML Editor   

  Show Tags Show HTML tags in the Fixlet editor. 

  Show Borders Show borders around the editable fields in the Fixlet 
editor. 

Refresh (F5) Refresh the site tree and the output Fixlet list to 
reflect any recent file additions or modifications. 
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TThhee  CCoonntteenntt  MMeennuu  

The Content Menu offers the following commands: 

New Digest… Create a new digest. Only available when a 
Fixlet database is connected. 

New Fixlet... Create a new Fixlet message. Only available 
when a digest is selected in the site tree. 

New Template... Create a new Fixlet template. Only available 
when a template folder is selected in the site 
tree. 

Add File... Add a file to one of the Fixlet site folders. Only 
available when a Graphics, BFAST, or Other 
Files folder is selected in the site tree. 

Insert Relevance  
Ctrl+R 

Create a new relevance clause for the currently 
open Fixlet message or digest. Only available 
when a Fixlet message, template or digest is 
open for editing in the document area. 

Insert Embedded 
Action 

In addition to buttons, you can insert actions 
as links in the html. These are typically in a 
template, but may also exist in individual Fixlet 
messages. Only available when a Fixlet 
message or template is open for editing in the 
document area. 

Edit Embedded 
Actions... 

Edit the embedded actions. Brings up a list of 
embedded actions to choose from. 

Insert Other… 
Ctrl+O 

Create a named field for the Fixlet message or 
digest that is open in the document area. Only 
available when a Fixlet message or digest is 
open in the document area. 

New Button... 
Ctrl+N 

Create a new button for the Fixlet message 
that is open in the document area. Only 
available when a Fixlet message is open for 
editing in the document area. 

Edit Buttons... Edit an existing button for the Fixlet message 
that is open in the document area. Only 
available when a Fixlet message is open for 
editing in the document area. 

Approve... Approve the Fixlet message, digest or template 
that is open in the document area. Only 
available when a message, digest or template 
is open for editing in the document area. 
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TThhee  TToooollss  MMeennuu  

The Tools Menu offers the following commands: 
 

Relevance Evaluator... 
Ctrl+E  

Launch the QnA relevance evaluator to test 
the relevance expressions in the currently 
open Fixlet message or digest. Only 
available when a message or digest is open.  

New Site...  Create a new site in the site tree. Only 
available when the database is connected. 

Import Site...  Imports a site into the site tree. Only 
available when the database is connected. 

Propagate... Propagates the contents of a site. Only 
available when a Fixlet site is selected in the 
site tree. 

Version History... 
Ctrl+H 

Launch the History dialog to compare past 
and present Fixlet messages and dialogs. 
Only available when a message or digest is 
open. 

 

 

TThhee  WWiinnddooww  MMeennuu  

The Window Menu provides Cascade and Tile options to quickly arrange the open 
documents in the main window. You can also use Ctrl+Tab to cycle through each document 
sequentially. 
 

Close All Close all the windows in the workspace 

Cascade Overlap all the open windows in the workspace 

Tile Tile all the open windows in the workspace 

Arrange Icons Convert open windows to title bar icons and arrange them 
along the bottom of the Document Area. 

1 Window #1 Each open window is listed in this menu for easy selection. 

 

 



BigFix Development Environment Page 10 
BDE MENUS March 7, 2003 

 © 2003 by BigFix, Inc. 
   

 

TThhee  HHeellpp  MMeennuu  

The Help Menu offers the following commands: 

 

Contents Provide online help. 

About BDE...  Display the version number and other information about this 
program. 
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Sites  

IInnttrroodduuccttiioonn  

There are several factors to consider when creating a Fixlet site. At a minimum, a site has 
digests, which are collections of Fixlet messages containing descriptive html files, 
relevance expressions and action scripts. For ideas on how to organize a site, refer to the 
example site that ships with BDE, or import an existing site from BigFix. Here are some 
general guidelines to follow when creating your Fixlet site: 

11  Define the scope of your site(s). A Fixlet site can address thousands of issues, 
including security holes, patches, bug reports, upgrades, virus alerts, driver updates, 
registry settings and more. As a Fixlet author, your job is to find an optimal way to 
structure and present your content. You have three basic levels of  hierarchy to work 
with: sites, digests and messages. Sites generally address an issue like security or a 
product like WinNT. Digests let you group Fixlet messages that share relevance or 
have similar urgency. Here are some possible scenarios: 
• An IT manager may decide to maintain only one internal Fixlet site to provide 

security updates and to enforce company-wide standards. For complete coverage 
of Microsoft vulnerabilities, the manager will subscribe to the BigFix site. The 
manager may also subscribe to certain manufacturer’s sites to ensure that all the 
most current drivers and applications are deployed across the network. For added 
security, some managers may create a local site and dedicate a group of 
computers to test outside Fixlet messages before deploying them company-wide. 

• A hardware manufacturer may decide to maintain a single Fixlet site for all its 
product lines, since its users typically have more than one of those products, and 
the products are easy to support. Should they need to do a recall or a driver 
update, only those computers with the affected hardware will be notified. 

• A software manufacturer may want to create a Fixlet site for each product and 
package it with the software. This gives them a chance to fix bugs in the field and 
to offer timely updates.  

• A software VAR may decide to create a Fixlet site for each product line it sells 
to increase its response time and lower its support costs. Each site provides an 
opportunity to target specific customers with notices of upgrades and related 
software, add-ons, plug-ins, etc. For each product, the VAR may work with the 
software developers on a shared, private development site.  

22  Define your digests. If you have several Fixlet messages with similar relevance 
clauses, you should consider grouping them into digests. Properly done, this will 
reduce multiple relevance evaluations to a single evaluation at the digest level, 
improving efficiency. Another technique is to group Fixlet messages by urgency. The 
most urgent messages would reside in a Fixlet digest with a short delay, while non-
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essential upgrades, for example, might  reside in a digest that is evaluated only once a 
day. 

33  Define your templates. Templates let you maintain a consistent look and feel across 
all the Fixlet messages in a site. Anything you wish to offer across a range of Fixlet 
messages should be placed in the template, including your corporate logo, standard 
links, background graphics, etc. Or you could create a series of templates with slightly 
different styles to distinguish different types of Fixlet message at your site. 

UUssiinngg  tthhee  SSiittee  TTrreeee  

The Site Tree, at the left side of the screen, represents Fixlet sites and all their associated 
files in a hierarchical, or tree, structure. The top level of the hierarchy is the Fixlet site. 
Clicking on the plus sign to the left of a site or a digest icon will expand it to expose its 
children. Depending on your preferences (File / Preferences), double-clicking on a digest 
will either open it for editing or expand it.  
 

 
 

Fixlet sites are a collection of digests and associated files, such as graphics. Notice that 
Fixlet objects have a number to the left of their icon. This corresponds to the current level 
of approval for the object. You may also see a red check mark indicating that the associated 
Fixlet object is checked out for editing in an external program. 
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There is a right-click menu available for each selectable object in the site tree. Depending 
on the highlighted object, the menu may include one or more of the following: 

Edit When a Fixlet message, template or digest is selected, this menu 
item will open it for editing in the main document area. When 
any other type of file is chosen, it will be edited it in the default 
program for its data type, as determined by its extension. When 
an external program is used for editing, the file is checked out of 
the database and a red check-mark is placed to the left of its icon 
in the site tree. 

Edit With… Brings up the Windows Open With dialog, where you can select 
a program to edit the selected file. Available for graphics, html, 
text, bat and other files. 

Save As… Brings up the Windows Save As dialog, where you can save the 
currently selected file in another folder or with a different name. 
Not available for Fixlet messages, templates or digests. 

Rename Rename Fixlet messages, templates and digests, as well as other 
file types. Not available for renaming a Fixlet site. 

Check In Check the highlighted Fixlet object back in after editing it in 
another program, such as a graphics application. When you check 
a file in, the red check next to its icon disappears to show that it 
is no longer checked out for editing. 

Undo Checkout Undo the checkout of the highlighted Fixlet object. The original 
data will remain unchanged and the red check next to its icon will 
disappear to show that it is no longer checked out. 

New Digest… Create a new digest in the selected site or within the selected 
digest. Only available when a Fixlet site or digest is selected. 

New Fixlet… Create a Fixlet message in this digest. Only available when a 
digest is selected. 

New Template… Add a template to the Template folder. Only available when a 
Fixlet site or a Template folder is selected. 

Add File… Brings up the Windows Open dialog to browse for a file to add to 
the selected folder. Only available when the Graphics, BFAST or 
Other Files folder is selected. 
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Send to List Send the selected object to the output list. If the object has 
children, they are all expanded in the output list. Available when 
any item in the site tree is selected. 

Copy Available when a Fixlet message, digest, template or other file is 
selected. 

Paste Only available when something has been copied to the clipboard. 

Delete Delete the Fixlet message, digest, template or other file. Not 
available to delete folders within a Fixlet site. 

Write out files Only available when a Fixlet site is selected. 

Propagate… Only available when a Fixlet site is selected. 

Export to XML… Available when a Fixlet message, template, digest or other file is 
selected. 

Approve… Set the approval level for the selected site object. Available when 
a Fixlet message, template, digest or other site file is selected. 
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SSeettttiinngg  PPrreeffeerreenncceess  ffoorr  tthhee  SSiittee  TTrreeee  

In the site tree, you can expand a digest icon  in two ways: 

• Click on the plus sign to the left of the icon. 

• Double-click on the icon. 
This is the default behavior, but if you prefer, you can change the double-click behavior to 
open the digest instead of expanding it. Here’s how: 

11  From the File menu, choose Preferences. 

22  In the Site Tree section, click on the Double-click opens digest radio button.  
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CCrreeaattiinngg  aa  FFiixxlleett  SSiittee    

You can create a new Fixlet site by following these steps: 

11  Select Tools / New Site. 

22  Key in the name of your Fixlet site at the Site Name prompt. 

33  Click OK. Your site will be entered in the site tree along with a base set of site folders: 
Graphics, BFAST files, Other Files and Templates. 
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IImmppoorrttiinngg  aa  FFiixxlleett  SSiittee  

You can import an existing Fixlet site by following these steps: 

11  Select Tools / Import Site.  

22  If the BigFix agent is running, you will be prompted to close it before continuing. 
Right-click on the BigFix icon in the task bar and select Exit BigFix from the pop-up 
menu. 

33  The Browse for Folder dialog is displayed as a standard directory tree. 

44  Select the folder that contains the MIME-encoded Fixlet files that you want to import, 
and click OK. The Import Site dialog is displayed. 

55  Change the Site Name if desired. 

66  Click Import. As the site is imported, you can monitor its progress in the Message 
Log area. If the import is successful, the imported Fixlet site is added to your site tree, 
along with all its associated files and folders. 
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EExxppoorrttiinngg  aa  FFiixxlleett  SSiittee  ttoo  XXMMLL  

You may want to export your Fixlet files to another program, for instance a third-party 
database program. If that program can import XML files, BDE provides an interface to pass 
the data. XML provides a standard for information transfer that is accepted by a wide 
variety of applications. Here’s how to export a Fixlet site (or any other Fixlet object) as 
XML data: 

11  Right-click on the Fixlet site (or other Fixlet object) you want to export and choose 
Export to XML from the pop-up menu.  

22  A Windows Save As dialog will appear, prompting you for a name for the XML file. 
Choose a folder and enter a name for the file. Click the Save button. The file will be 
saved with named field for each object followed by its value. 

33  The saved file can now be imported as XML by another program. Typically, upon 
importing, the receiving program will display the field names and let you arrange them 
as you wish. 

IImmppoorrttiinngg  aann  XXMMLL  FFiillee  

You can import XML files created in other programs, or by BDE itself. This might be 
useful for importing data from an existing knowledge base or another Fixlet site. You may 
only import a file into an appropriate location in your existing Fixlet sites. Here’s how: 

11  Select File / Import from XML. 

22  A Windows Open dialog will appear. Locate the file you want to import and click the 
Open button. 

33  The Import From File dialog will open. The information is extracted from the XML 
file and displayed as a Fixlet tree structure in the left panel.  

44  Open the tree to any level desired and click on any entry to import.  

55  The right panel has a tree representing the currently connected sites. Select the Fixlet 
site, digest, message or folder where you want the imported file to reside. Note that the 
Import button will not become active until an appropriate residence is selected. For 
instance, a Fixlet message can only be imported into a digest, not a site or a folder. 
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DDeelleettiinngg  aa  FFiixxlleett  SSiittee  

Only a BDE administrator may delete a Fixlet site. When deleted, the site and all its 
contents are permanently removed from the BigFix Development Environment database. If 
you expect to restore the site later, you should archive it before you delete the site. 

11  In the site tree panel, right-click on the Fixlet site you want to delete and select Delete 
from the pop-up menu.  

22  Select Yes from the Confirm Deletion dialog. 

33  The Verify Login dialog is displayed. Enter your administrative password and click 
OK to delete the Fixlet site. 
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Digests 

OOvveerrvviieeww  

Fixlet messages are packaged into digests, allowing you to fine-tune their evaluation 
schedule, improve efficiency and reduce the overhead of multiple file fetches. Digests are 
hierarchical, helping you to organize your Fixlet site while promoting even greater 
efficiency. The digest properties that accomplish these feats include: 
Delay: Digests are scheduled using a delay field. By default, Fixlet messages within a 
digest will be evaluated once a second. You can increase this delay for digests containing 
less urgent messages, like product updates. You might also set a longer delay for digests 
containing resource-intensive Fixlet messages which you want to be evaluated infrequently. 
Relevance: Great efficiencies are achieved by adding relevance expressions to an entire 
digest, not just the individual Fixlet messages. If a group of Fixlet messages shares a 
relevance clause, the wise Fixlet author will encapsulate them in a single digest and move 
the clause up to the digest level. The relevance clause will then be evaluated once for the 
whole group instead of multiple times. 
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CCrreeaattiinngg  aa  DDiiggeesstt  

Before you can create a Fixlet message, you must define the digest that will contain it. To 
create a new digest, follow these steps: 

11  From the site tree at the left of the screen, highlight the site (or the digest) where you 
want your new digest to reside.  

22  Right-click on the icon, and select New Digest. (Or select Content / New Digest.) 
 

 
33  Type in the your desired Digest Name. 

44  Enter the Delay parameters, which indicate how often BigFix should evaluate the 
digest. The default is to evaluate all the children in the digest on the same schedule. If 
you want a different evaluation period for the Fixlet messages within the digest, 
uncheck the “Use same delay for children” option and choose the appropriate values 
from the Child Delay fields. If the child delay is longer than the digest delay, this 
object will be evaluated less often. If the child delay is shorter than the digest delay, it 
will override the digest delay. 

55  Press OK to add the new digest to the site tree. 
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AAddddiinngg  RReelleevvaannccee  ttoo  aa  DDiiggeesstt  

You may discover you have several Fixlet messages that include the same relevance clause, 
such as: 

��  name of operating system = "WinNT" 
 

These messages should be packaged into a single digest. Move the relevance expression up 
a level; out of the Fixlet messages and into the digest. That way, the test will only be 
performed once for all the Fixlet messages in the digest, sparing system resources. 

To add relevance expressions to a digest, follow these steps: 

11  From the site tree, right-click the desired digest icon and choose Edit from the pop-up 
menu. Or (depending on your Preferences settings) double-click on the digest icon. 

22  Click the Insert Relevance icon from the toolbar  (or select Content / Insert 
Relevance). It will create a text-entry box labeled Relevance in the field section at the 
right of the screen. 
 

 
33  In the Relevance field, key in the appropriate clause. See the BigFix Windows 

Inspectors Library documentation for more information on the syntax of the 
Relevance langauage. 
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SSeettttiinngg  tthhee  DDeellaayy  oonn  aa  DDiiggeesstt  

The digest delay field dictates the time between successive Fixlet evaluations. A short delay 
will cause urgent Fixlet messages to be evaluated more frequently, while a long delay is 
used for less urgent messages that can wait, reducing the use of system resources. Here’s 
how to set the digest delay: 

11  From the site tree, right-click a digest icon and choose Edit from the pop-up menu. Or 
(depending on your Preferences settings) double-click on the digest icon.  

22  In the field section, you may set the evaluation period for the digest and the items 
contained within it. This determines how often the digest and its children (if any) are 
evaluated on the user’s computer. In the general case, you will want to set the Delay 
and Child Delay to the same value.  

33  The units of time in the delay fields include millisecond(s), second(s), minute(s), 
hour(s) and day(s). 

SSaavviinngg  aa  DDiiggeesstt  

Whenever you make changes to a digest, an asterisk (*) will appear in the BDE Title bar to 
the right of the digest name. Changes that you make to the digest will not be committed to 
the database until you close the digest itself.  

11  Click the Save icon in the toolbar, select File / Save or click the Close Window icon. 
 

 
 

22  If any changes were made to the digest, a confirmation message may appear. 
 

 
 

33  If the digest has previously been propagated, select Continue Propagating Old 
Version to recommend that the currently propagated version continues to be published 
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while the digest is being edited. Select Remove Object Pending Approval to 
recommend that the digest and all Fixlet messages inside be removed from the 
published site while the digest is being edited. 

44  Select Yes to commit your changes to the database and exit, No to abandon your 
changes and exit, or Cancel to return to the document you were editing. 

RReennaammiinngg  aa  DDiiggeesstt  

11  Click on the name of the digest in the site tree to select it. 

22  Click a second time to make the name field editable or right-click on the digest name 
and select the Rename option from the pop-up menu. 
 

In addition, you can rename a digest from within the Digest Edit function 

11  From the site tree, right-click a digest icon and choose Edit from the pop-up menu. Or 
(depending on your Preferences settings) double-click on the digest icon.  

22  Change the Name in the Field Section at the right of the screen. 
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MMoovviinngg  oorr  CCooppyyiinngg  aa  DDiiggeesstt  

For easier maintenance or more efficient evaluation, you may want to move one digest 
within another. Or you may want to copy a digest from one site to another. Both operations 
follow these steps: 

11  Click on the digest to move or copy and drag it to the desired location. 

22  Once you have the mouse pointer over a site icon or digest icon, release the mouse to 
drop the digest into its new location. 

The final location of the digest will determine whether a Move or Copy function is 
performed: 

• If you drop the digest within the same site, it will move the digest.  

• If you drop the digest on a different site, it will copy the digest. 

DDeelleettiinngg  aa  DDiiggeesstt  

One of the folders contained within each site is labeled Trash. When you delete a digest, 
the digest and all of its contents will be sent to the Trash folder, which saves a copy of it 
which can be reclaimed later if necessary. 

 

11  Right-click on the digest you want to delete and select Delete from the pop-up menu. 

22  From the delete confirmation menu, select Yes to send the digest and all of its contents 
to the site trash folder or No to cancel the delete process. 

RReessttoorriinngg  aa  DDeelleetteedd  DDiiggeesstt  

If you accidentally delete a digest, you can retrieve it from the trash: 

11  Expand the Trash icon within the respective site. 

22  Right-click on the digest to be restored and select Undelete from the pop-up menu. 
The digest will be restored to the exact location within the site from which it was 
originally deleted.  
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Templates 

IInnttrroodduucciinngg  FFiixxlleett  TTeemmppllaatteess  

The Fixlet template facilitates rapid development of new Fixlet messages and provides a 
consistent look and feel to your site. The template is a web page that uses HTML comments 
(<!--comment-->) to embed named fields. These named fields will hold the variable Fixlet 
information, including the title, description and action buttons. 
Since the template is defined using standard HTML, you may already have the graphics, 
links, and assorted boilerplate you need to quickly assemble a Fixlet template. If you have a 
web page that currently addresses support problems, you might want to start with that as 
your prototype template. You’ll just need to insert your template fields where you want 
them to show up in the web page.  
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This is the template used to create the above Fixlet message: 
 

 
 
The Name field is required and serves as the title of the Fixlet message. If you click on the 
Source tab at the bottom of the display area, you can find the HTML comments that define 
the Name field: 

��  <!--StartFixletField$Name$-->Name<!--EndFixletField--> 

 

The word in between the two HTML comment tags (Name) is the default value for this 
field. When data is being entered into this field of the template, the information will be 
mirrored in the field section.  
The red outlined box (with Field#1 in it), is a numbered description field for the fixlet 
message. This place-holder is also defined in the HTML source:  

��  <!--StartFixletField$__Field#1$-->Field#1<!EndFixletField--> 

 
Because this field name starts with two underscores (__Field#1) the information will not be 
mirrored to the field section during data entry. This lets you control how much of your data 
you want to be reflected in the field section. Large fields, especially those with HTML 
elements, are easier to deal with in the display area than the field section. 

There is a place holder in the HTML source to identify the placement of the action buttons, 
which typically follow directly after the description field. The HTML looks like: 

��  <!--StartFixletButtonArea--><!—EndFixletButtonArea--> 

 
Notice that there is no default value for the button, which has its own template and will be 
added later. 
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This template includes the Delete this Fixlet option (near the trashcan icon). Because it is 
defined at the template level, it will be in effect for each Fixlet message that uses it. The 
HTML for the Delete command looks like: 

��  <a href=cid:TemplateAction1>Delete this Fixlet</a> 

 

Notice that delete is not an input field, but an action. Actions are numbered, and this action 
refers to TemplateAction 1, which is listed in the field section. The action is the simple 
BigFix action command Fixlet delete. Actions are discussed in greater detail elsewhere in 
this document. 

NNaammiinngg  TTeemmppllaattee  FFiieellddss  

A template field can be a simple text field, or it can be a full-fledged section of HTML. 
Text fields can satisfy many of your needs, but most Fixlet authors use HTML for the Fixlet 
description field. This lets them include illustrations, tables and different fonts to better 
describe the issue at hand. An HTML field will have a name like HTML_name to 
distinguish it from a text field. 
When you start to enter data using your templates, you’ll notice that the data is mirrored in 
the field section (at the right side of the BDE window). When you define a field in a 
template, you can also choose not to mirror it, saving room in the field section. If you don’t 
want the field data mirrored, start the field name with two underscores, like __name. 
The following chart explains the naming convention for all four combinations of these two 
field types: 

 Mirrored in Field Section Not mirrored in Field Section 

HTML HTML_fieldname __HTML_fieldname 

Text fieldname __fieldname 

 

Here’s how you might define a simple text field named Title: 

��  <!--StartFixletField$Title$-->Enter Title<!--EndFixletField--> 

 
You can’t enter HTML into a text field, but you can apply an HTML style to the entire field 
by embedding it between tags, like these header tags: 

��  <h2><!--StartFixletField$Title$-->Enter Title<!--
EndFixletField--></h2> 

 
Here’s what a non-mirroring HTML field called Description would look like: 

��  <!--StartFixletField$__HTML_description$-->Enter description 
here.<!--EndFixletField--> 
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CCuussttoommiizziinngg  aa  FFiixxlleett  TTeemmppllaattee  

By far the easiest way to get a Fixlet site up and running is to customize an existing set of 
templates. However, while they provide the foundation for your Fixlet messages, templates 
themselves are not propagated. Find a template that has an appropriate set of fields, and edit 
it with an HTML editor like FrontPage or DreamWeaver. These programs leave HTML 
comments intact, which means that the field definitions will survive the editing process. 
Don’t use programs like Word to edit your HTML, because they bloat the code and may 
introduce errors into your Fixlet template. 

11  Find an existing template, say template.htm, and copy it to a staging folder. 

22  Copy all the graphics you need to this staging folder. Don’t include any subdirectories 
in this folder – the program that displays Fixlet messages is expecting a flat directory 
structure. Images and other external files should be linked as relative siblings, rather 
than with absolute pathnames: 

��  <img src=”icon.gif” border=0> 

 
Not: 

��  <img src=”/images/icon.gif” border=0> 

 

33  Launch an HTML editor, like FrontPage or DreamWeaver, and edit the template for 
the proper look, always linking to graphics and other related files as siblings in the 
staging folder. 

44  Save the template to the staging folder. 

55  Copy the HTML source of the template into the paste buffer. 

66  Launch or switch to the BDE from your HTML editing program. 

77  Right-click on the desired template folder and select New Template from the pop-up 
menu.  

88  At the New Template dialog, enter a Template Name and click OK. 

99  Select the Source Tab beneath the display area.  

1100  Press Ctrl+A to highlight the existing text and mark it for replacement. 

1111  Press Ctrl+V (or Edit / Paste) to replace the existing default text with the edited 
template that you placed in the paste buffer. 
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IInnsseerrttiinngg  TTeemmppllaattee  FFiieellddss  

You can insert fields into a template using the HTML source editor: 

11  In the site tree, right-click the desired template and select Edit from the pop-up menu. 

22  Select the Source Tab beneath the display area. 

33  Click in the HTML code where you want to place the field. 

44  Insert the following text to create a field named myfield: 

��  <!--StartFixletField$myfield$-->Enter myfield<!--
EndFixletField--> 

55  Check the results by clicking on the Preview tab beneath the display area. 

DDeelleettiinngg  aa  FFiixxlleett  TTeemmppllaattee  

One of the folders contained within each site is labeled Trash. When you delete a digest, 
the digest and all of its contents will be sent to the Trash folder, where it can be reclaimed 
later if necessary. 

11  Right-click on the digest you want to delete and select Delete from the pop-up menu. 
(Or just drag it into the Trash icon). 

22  From the delete confirmation menu, select Yes to send the template to the site trash 
folder. 
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Fixlet messages 

CCrreeaattiinngg  FFiixxlleett  MMeessssaaggeess  

A Fixlet message has three basic elements: 

• Relevance: The relevance clause determines if the message 
applies to the user’s machine.  

• Text: This explanatory HTML page is what the user will see if 
the message is relevant. 

• Action: The actions are commands provided for the user to 
resolve the issue or conflict. 

 
The Fixlet messages are packaged in digests, which can contain one or more messages. So 
first a digest must be created (see Creating a Digest). Here are the steps to creating a Fixlet 
Message: 

11  In the site tree, click on the digest which should contain the new Fixlet. 

22  From the Content menu, select New Fixlet. (You can also right-click on the digest and 
choose New Fixlet from the pop-up menu). The New Fixlet Dialog will appear.  
 

 
 

33  In the Title field, enter a name for the Fixlet message. This title will become the 
default title of the HTML page the user will see. If you wish, you can change that title 
later from the Document editor. 

44  Use the ID field to uniquely number each Fixlet message you create. Each time you 
create a new Fixlet message within a digest, the ID field will be automatically 
incremented by one. If you need to change the ID—to match a Knowledge Base ID 
number, for example—modify it now: Once you set an ID number for a Fixlet 
message, you can’t change it. You may, however, issue the same Fixlet message with 
a new ID number. 
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55  Use the Template field drop-down list to select the appropriate HTML template for 
the message body. 

66  After you press OK the Fixlet message will be added to the site tree and a new 
document based on the chosen HTML template will appear in the document area. 
 

 
 

A typical template has at least two editable fields:  

• The Title area is a text field bounded by a blue box. You may enter any text values 
you want.  

• The Description area is an HTML field bounded by a red box. It will support any 
standard HTML syntax. 

The number of editable fields that appear, the type of entry each supports, and the default 
value that appears within a field are controlled by the template. You may change any values 
inside the editable field areas; the template areas are safely locked for editing in this 
window. (To change the template, find the desired template in the Template folder and  
double-click to open it in the editor.) 
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DDeeffiinniinngg  RReelleevvaannccee  CCllaauusseess  

Each Fixlet message has one or more relevance clauses. This is the heart of a Fixlet 
message; the part that determines whether or not the message is pertinent to a particular PC.  

11  There are three ways to insert a relevance clause into a Fixlet message: 
• From the Content menu, select Insert Relevance.  
• From the toolbar, click the Relevance icon. 

 

 
• Within the field section, right-click and choose Insert Relevance from the pop-

up menu.  

22  A new text box will be added to the field section where you can type in a Relevance 
clause. (See the Windows Inspectors Library documentation for information on the 
syntax of the relevance language.) 
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EEvvaalluuaattiinngg  RReelleevvaannccee  CCllaauusseess  

At any time, you can dynamically execute any relevance clause. This is useful to test the 
syntax or to evaluate the clause on your local machine. Here’s how: 

• With focus in any field within the field section, select Relevance Evaluator from the 
Tools menu, or press Ctrl+E. The Relevance Evaluation tool will launch with the 
currently viewed relevance clause or clauses copied into the window and evaluated. 
You can modify the relevance statements and re-evaluate them by clicking the 
Evaluate button or pressing Ctrl+E. You can also test new statements by preceding 
them with “Q:” 
 

 
 

Note: When the Relevance Evaluation window is closed its contents will be discarded. If 
you have modified the Relevance statements and wish to save the results, be sure to copy 
them from the window before closing it. 
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CCrreeaattiinngg  tthhee  FFiixxlleett  BBooddyy  

The Fixlet display appears to the user as an HTML document within the BigFix Agent 
browser. The basic structure of the display is provided by the templates that have been 
created for the site. Typically, the HTML display will include three parts: 

• Title: Describes the essence of the Fixlet message. 
• Description: Provides a brief background of the issue. 
• Action Button(s): Enables the end-user to resolve the issue.  

As an HTML document, the display may also include graphics for illustrative purposes and 
to provide branding. A folder labeled Graphics is automatically provided to hold image 
files when you create a new digest. 
To create or edit the Fixlet display: 

11  Double-click on the Fixlet message in the site tree. The template, along with any 
existing content, will be displayed in the document area.  

33  Make sure the Edit tab at the bottom of the document area is selected and then enter or 
edit the display.  

44  Select the Preview tab to see what the final HTML display will look like. 

55  Select the Source tab to view or edit the HTML code. 
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RReennaammiinngg  tthhee  FFiixxlleett  MMeessssaaggee  

When you add a new Fixlet message to the site tree, the title area of the HTML document 
defaults to the name of the Fixlet message. There are three ways to change the Fixlet name 
(and title) and they are all linked. Changing any one of them changes them all:  

• To change the name in the field section, click in the Name field and make the desired 
changes.  
 

 
• Select the Edit tab and modify the text in the Title area. 

• To change the name in the site tree, right-click on the Fixlet name and select Rename 
from the pop-up menu, or click twice on the name to enter an edit mode. 
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MMooddiiffyyiinngg  tthhee  FFiixxlleett  DDeessccrriippttiioonn  

The description in your Fixlet message should briefly explain the detected condition to the 
user. To avoid overwhelming a user with unnecessary information, you’ll want to keep your 
descriptions brief. For expert users who want to know all the facts surrounding a fix, you 
can always provide a link that will take the user to a page with more detailed information. 
To add or modify a Fixlet description, follow these steps: 

11  Select the Edit tab below the document area 

22  Enter the Fixlet description in the body box of the document area. 
 

 
 

33  Depending on the design of the template you selected, you will have different options 
for entering text into the Fixlet message area. 
• A blue box designates a Text area, that is, only text—no HTML commands—

may be entered. 
• A red box designates an HTML area in which you may use any valid HTML 

syntax to enhance the appearance of your text.  
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AAddddiinngg  HHTTMMLL  TTaaggss  

For more control over the appearance of your Fixlet description, you can add HTML tags: 

11  Select the Edit tab beneath the document area. 

22  Right-click within an HTML field in the document area. A pop-up menu will appear.  
 

 
33  Select from Image, Hyperlink, Font, Table and Style to add an HTML tag to the 

given section of text. 
 

EEddiittiinngg  HHTTMMLL  TTaaggss  

After adding HTML tags to a Fixlet message, you may need to edit them. Here’s how: 

11  Open the desired Fixlet message. (Double-click on the desired Fixlet message in the 
site tree.) 

22  Click the Source tab beneath the document area. 

33  Edit the appropriate HTML tags. 
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AAddddiinngg  IImmaaggeess  

You can add images to the Fixlet description and they will automatically be added to the 
Graphics folder for this site. Here’s how: 

11  Select the Edit tab beneath the document area. 

22  Right-click in an HTML area in the Fixlet display. 

33  From the pop-up menu, select Image. The Picture dialog will appear. 
 

 
 

44  Type in the full pathname of a Picture Source or click the Browse button to find the 
image in the file system. 

55  Fill in any of the other optional fields for the image. These include: 
• Any Alternate Text you want to accompany the image. (This text will show up 

in browsers that don’t display images.) 
• The Alignment of the image. Alignment choices include Left, Right and Center, 

among others. The default is Baseline, which places the graphic on the current 
text line. 

• The Border Thickness. Set this value to zero (0) to eliminate the border. 
• The Horizontal and Vertical white space around the image. Use spacing along 

with alignment to position the image in a box embedded in the surrounding text. 

66  Click OK. If the image file is not already stored at this site, a dialog will pop up and 
offer to copy the image into the site graphics folder.  

77  Click OK to copy the file. The image will be displayed in the appropriate HTML 
section of the document area. 
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MMooddiiffyyiinngg  IImmaaggeess  

You can modify the optional fields associated with an image. Here’s how: 

11  Right-click on the image. 

22  Select Image from the pop-up menu. 

33  Modify the desired image options. 

44  Click OK. 

AAddddiinngg  TTaabblleess  

You can add tables to the HTML sections of the Fixlet message. Here’s how: 

11  Select the Edit tab beneath the document area. 

22  Right-click in an HTML area in the Fixlet display. 

33  From the pop-up menu, select Table / Insert Table. A two-by-two table will be 
placed in the HTML section of the Fixlet display, and a default table caption will be 
placed above it. 

MMooddiiffyyiinngg  TTaabblleess  

You can modify the tables that appear in the HTML sections of the Fixlet display. Here’s 
how: 

11  Select the Edit tab beneath the document area. 

22  Right-click in a table in an HTML area of the Fixlet display. 

33  Select Table from the pop-up menu.  
 

 
44  From the submenu, select the desired modifier to insert, delete, split or merge the table 

elements.  
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AAppppllyyiinngg  SSttyylleess  

You can apply several standard HTML styles to the text in the Fixlet description. You can 
align the text and set styles like headers and lists. Here’s how: 

11  Select the Edit tab beneath the document area. 

22  Right-click an item in an HTML area of the Fixlet display. 

33  From the pop-up menu, select Style. 
 

 
44  From the sub-menu select the desired style. 
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SSaavviinngg  aa  FFiixxlleett  MMeessssaaggee  

Whenever you make changes to a Fixlet message, an asterisk (*) will appear in the BDE 
Title bar to the right of the Fixlet name. Changes that you make to the Fixlet message will 
not be committed to the database until you close the Fixlet itself. 

11  Click the Close Window icon. 
 

 
 

22  If any changes were made to the Fixlet, a confirmation message will appear when you 
close the window. 
 

 
 

33  If the Fixlet has previously been propagated, select Continue Propagating Old 
Version to recommend that the currently propagated version continue to be published 
while the Fixlet undergoes editing. Select Remove Object Pending Approval to 
recommend that the Fixlet be removed from the published site while it is being edited. 

44  Select Yes to commit your changes to the database and exit, No to abandon your 
changes and exit, or Cancel to return to the document you were editing. 
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MMoovviinngg//CCooppyyiinngg  aa  FFiixxlleett  MMeessssaaggee  

Moving or Copying Fixlet messages can be accomplished using the same techniques as 
moving and copying a digest. 

11  Click on the Fixlet message to move or copy and drag it to the desired digest. 

22  Release the mouse button to drop the Fixlet message into its new location.  

33  The location of the digest the Fixlet is dropped in will determine whether a Move or 
Copy function is performed. 
• If you drop the Fixlet message in a digest within the same site, it will move the 

Fixlet.  
• If you drop the Fixlet message into a digest on a different site, it will copy the 

Fixlet message to that location. 

DDeelleettiinngg  aa  FFiixxlleett  MMeessssaaggee  

One of the folders contained within each site is labeled Trash. When you delete a Fixlet 
message, the Fixlet and all of its contents will be sent to the Trash folder so that it can be 
reclaimed later if necessary. 
 

11  Right-click on the Fixlet message to delete and select Delete from the pop-up menu. 

22  From the delete confirmation menu, select Yes to send the Fixlet message and all of its 
contents to the site trash folder or No to cancel the delete process. 
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RReessttoorriinngg  aa  DDeelleetteedd  FFiixxlleett  MMeessssaaggee  

11  Expand the Trash icon within the respective site 

22  Right-click on the Fixlet message to be restored and select Undelete from the pop-up 
menu. The Fixlet will be restored to the exact location within the site from which it 
was originally deleted. 
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  FFiinnddiinngg  TTeexxtt  wwiitthhiinn  aa  FFiixxlleett  MMeessssaaggee  

To search for a text string within a Fixlet message: 

11  Click anywhere within the document pane. 

22  Press Ctrl+F to bring up the Find dialog box. 
 

 
 

33  Key in the text you want to find and click the Find Next button. 
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FFiinnddiinngg  OObbjjeeccttss  

As you are developing and maintaining Fixlet messages, you may want to locate Fixlet 
messages that share a particular characteristic. The Find Object capability will enable you to 
quickly locate any Fixlet based on the text in the Title, Relevance, or Action fields. Here’s 
how: 

11  Select Find Objects from the Edit menu. The Find Objects dialog will be displayed, 
with the current site as the default. 

22  Key the appropriate search criteria into the Find Objects dialog. You can choose to 
Find Objects containing or not containing the value. The value itself may include 
the % or _ characters as described in the WildCard section. 
 

 
 

33  Select the Fixlet site you want to search from the pull-down menu. 

44  Select the fields you want to search for the specified value: 
• All will search for the text in any part of the Fixlet message: Title, Relevance, 

Action and the underlying HTML. 
• Title will search only in the Fixlet title text field. 
• Relevance will search only in the Fixlet relevance clauses. 
• Action will search only in the Fixlet action fields. 
• Other will allow you to find data in the specified field. 

55  Select where in the field you expect to find the string in the Match String section. 

66  Click Find. The results returned from the search will be displayed in the output list at 
the bottom of the screen. 
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UUssiinngg  tthhee  OOuuttppuutt  LLiisstt  

The output list window holds the results of the Find Objects operation as well as the Send 
to List function. In addition to the ability to open a Fixlet message from the output list, you 
can sort the output list by any column of the window. Here are some of the features of the 
output list: 

• To populate the output list from the site tree, right-click on a Fixlet message in the site 
tree and select Send to List from the pop-up menu. 

• Click on any heading label to sort the list. 
 

 
• Open any Fixlet message by double-clicking on it. 

• To expand the parents of the selected item in the site tree, right-click on a Fixlet 
message and choose the Select In Tree option. 

• The pop-up menu Send to List option will repopulate the output list as if the item had 
been selected from the tree view and expanded into the list. 

• Select Refresh from the View menu or press the F5 shortcut key to update the entries 
in the output list to reflect any recent file additions or modifications. 

• Shift- and ctrl- click on the items in the list to select them. You may then copy and 
paste your selection into Excel. 
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VViieewwiinngg  tthhee  VVeerrssiioonn  HHiissttoorryy  

As you are developing your Fixlet messages, the BDE maintains a version history that you 
can access to better understand the changes you or others have made. The Version History 
dialog will let you compare a previous version of a Fixlet message to the current version. 

11  Double-click a Fixlet message in the site tree to open it. 

22  From the Tools menu, choose Version History or press Ctrl+H.  

33  From the left column, select an older version of the Fixlet message for comparison. 
Select a later version from the second column. 
 

 
 

44  Use the Options menu selections (or the toolbar icons) to view specific differences: 
• Elements Identical in both versions. 
• Elements Changed in both versions (highlighted in red). 
• Elements Added to the later version (highlighted in green). 
• Elements Deleted from the previous version (highlighted in blue). 
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Action Buttons 

CCrreeaattiinngg  AAccttiioonn  BBuuttttoonnss  

Typically, after a Fixlet message becomes relevant, it will offer one or more actions to 
address the problem. In addition, a Fixlet message might also provide links to a more 
detailed explanation of the problem, links to the respective support pages for the products 
involved, or links to the appropriate on-line store so the user can purchase any required 
software or hardware to resolve the issue.  

Ideally, a relevance expression is coded in such a way that once the fix has been applied, the 
Fixlet message will automatically disappear. If that’s not possible, the Fixlet message 
should include an action button to delete itself after the action has been taken. 
To create an action button, follow these steps: 

11  Create a new action button in one of two ways: 
• From the Content menu, select New Button 

• From the toolbar, choose the Button icon:   

22  Using either method, a dialog will appear for you to define the characteristics of the 
new button. From the Template dropdown list, select a pre-defined template to use. 
This template determines the image that will appear next to the action. 
 

 
33  Select the Action Type. The default is a Windows Fixlet Shell Script, but you can also 

select FindFile, Registry files, Visual BASIC and JavaScript, among others. 
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44  Click OK. An entry will be made in the Fixlet HTML document for you to add 
descriptive text to the button. An entry will also be made in the Field section, where 
you can define the action script for this button. 
 

 
 

55  Modify the default text in the Fixlet display to provide an informative prompt for the 
user. 

66  In the Action field, describe the action you want to execute. This can take one of 
several forms. Here are two common action types you can use: 
• Add a BigFix action command or list of commands that will execute when the 

button is selected by the user. See the documents Authoring Fixlet messages and 
The BigFix Action Commands for a complete explanation. 

• Key in the full URL of a web page you want the user to link to when the button is 
selected by the user.  

Note: Action Button numbers correspond to their order in the Fixlet Body. Thus, Action #3 
is the third action in the HTML, starting from the top. 
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CChhoooossiinngg  aa  DDeeffaauulltt  AAccttiioonn  

After you’ve created an Action Button or two, you can choose to set one of them to be a 
default Action. The default is your recommendation for which action should be applied. 
This will allow users to select it as an automatic action, if they so choose.  
To choose a default,  

• From the drop-down list labeled Default Action, select an action to be the default. 

MMooddiiffyyiinngg  aann  EExxiissttiinngg  AAccttiioonn  BBuuttttoonn  

You can modify existing buttons with the Edit Buttons dialog. Here’s how: 

11  Right-click on the text of an existing action button or from the Content menu, choose 
Edit Buttons. The Edit Buttons dialog is displayed. 
 

 

22  From the the Select Button list, highlight the button you want to change. 

33  If you want to use a different template for this button, choose it from the Template 
drop down list. 

44  If you want to associate the button with a different action type, select the Action Type 
dropdown list and make the appropriate change. 
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DDeelleettiinngg  aann  AAccttiioonn  BBuuttttoonn  

There are three ways to delete an action button from a Fixlet message. 

• Right-click on the text of the button and choose Delete from the pop-up menu. 
 

 

• Or, choose Edit Buttons from the Content menu. Highlight the button you want to 
delete from the Select Button list and click Delete.  
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• Or, right-click in the action field and choose Delete Field from the pop-up menu. 
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Other Fixlet Fields 

AAddddiinngg  DDeevveellooppeerr--DDeeffiinneedd  FFiieellddss  

In creating Fixlet messages, you may find a need to add your own fields. For example, an 
“Author” field could be created to identify the creator of the Fixlet. A “Changes” field 
might be used to document the modifications that have been made to a Fixlet since its 
original creation. Or you may want to display some text data to the end users such as an 
incident number or knowledge-base ID associated with the Fixlet message they are viewing. 

11  Choose the Insert Other option from the Content menu or from the right-click pop-
up menu of the field section. You will be prompted to give your new field a name. 

 
22  Key in a name for the field and press OK. Your new custom field will be added to the 

field section after your Relevance and Action statements. 
 

 
33  Type in an appropriate value for the field. 
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DDiissppllaayyiinngg  DDeevveellooppeerr--DDeeffiinneedd  FFiieellddss  

Usually a developer-defined field is hidden from the user, but if you want its value to be 
displayed as part of the Fixlet message, then a reference to the field should be defined as 
part of the Fixlet template. This could be used to display a knowledge-base number or a 
checklist of fields to be filled out by the author. Here’s how: 

11  In the site tree, double-click on a template to select it. 

22  Click the Source tab beneath the document area. 

33  Position your cursor in the HTML where you want the developer-defined field to be 
displayed. 

44  Enter a line of HTML to create a numbered Fixlet field called name: 

��  <!--StartFixletField$name#1$--><!--EndFixletField--> 

 

55  To use this template, right-click on a digest and choose New Fixlet from the pop-up 
menu. 

66  Name the Fixlet message and select the template with the developer-defined field. 
Click OK. 

77  You’ll notice an extra field in the display. When you type into it, it will automatically 
create a developer-defined field that will show up in the field section. 

 

 

DDeeffiinniinngg  KKeeyywwoorrddss  aanndd  HHeeaaddeerr  FFiieellddss  

Developer-defined fields named “Keyword”, “Keywords” or of the form “MIME_anything” 
will be exported in the Fixlet MIME header. These fields will then be viewable to the user 
in the Fixlet message’s header. Here’s how to create a keyword: 

11  Choose the Insert Other option from the Content menu or from the pop-up menu of 
the field section. You will be prompted to give your new field a name. 

22  Type in the phrase Keyword and press OK. Your new keyword field will be added to 
the field section after your Relevance and Action statements. 

33  Type in an appropriate value for the field. 
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DDeelleettiinngg  aa  DDeevveellooppeerr--DDeeffiinneedd  FFiieelldd  

Remove a developer-defined field as you would a relevance clause or action: 

• Right-click inside the field you want to delete and choose Delete Field from the pop-
up menu. 
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Propagation 

TThhee  AApppprroovvaall  PPrroocceessss  

Typically, you will set a designated minimum approval level for each stage of the Fixlet 
development process, including authoring, development, testing, QA and production. For 
example, you might designate the following approval levels: 

 

Level Number Stage 

0 Authoring 

1 Testing 

2 Integration Testing 

3 Regression Testing 

4 Quality Assurance 

5 Production 

 
The BDE administrator will define the highest level to which each individual is allowed to 
promote content.  
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AApppprroovviinngg  aa  SSiittee  EElleemmeenntt  

11  From the site tree, right-click on the digest, Fixlet message, or related file and select 
the Approve option from the pop-up menu (or press Ctrl-P). To approve more than 
one site element at a time, select them using shift and ctrl click. 
 

 
 

22  Key in your password and designate the level to which the Fixlet site element should 
be approved. 
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33  If the Fixlet site element has previously been propagated, the approver can make a 

recommendation as to whether or not that prior version of the element should be 
pulled from propagation while the current version is being edited and re-approved. 

Note: The Approval options will not be available if the content element has already been 
approved to a level higher than the one assigned to the developer. 

AApppprroovviinngg  MMuullttiippllee  SSiittee  EElleemmeennttss  

Use the output list to select and approve multiple items at once for approval: 

11  From the site tree, right-click on the desired site elements and select Send to List. 

22  From the output list, shift and ctrl-click to select and highlight the items to be 
approved.  
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33  Right-click the highlighted items and choose Approve from the pop-up menu. 

44  Key in the appropriate password and designate the correct approval level and 
propagation recommendation. 
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VViieewwiinngg  AApppprroovvaall  HHiissttoorryy  

To track the progress of a Fixlet object as it gets approved to higher levels, follow these 
steps: 

11  Select Tools / Version History, or press Ctrl+H. The Version History dialog is 
displayed.  

22  From the pull-down menu in upper left corner, select Approval History. A complete 
list of all approvals ever made on this object is displayed. 
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PPrrooppaaggaattiinngg  aa  FFiixxlleett  SSiittee  

Site Propagation often involves several different people, including IT managers, network 
administrators, BDE administrators and Fixlet authors. In order to coordinate this inevitable 
overlap of interests, BDE helps you to create local staging areas and batch-style scripts to 
automate the process. 

Propagating the site extracts the Fixlet information you’ve created and generates all the 
Fixlet files you need for deployment on your Fixlet server. These files will be written to the 
folder specified by the Local Folder parameter of the Propagate Site dialog. Because the 
process of digitally signing the Fixlet content and transferring the files to another location 
can take several steps to complete, most authors will want to codify the procedure in a 
script. If a script is indicated, it will be executed after the Fixlet site files have been written 
to the local folder. 

11  From the site tree, right-click on the site you want to propagate. 

22  Choose Propagate from the pop-up menu (or choose Tools / Propagate). The 
Propagate Site dialog will be displayed.  
 

 
33  Select a Propagation Profile from the pull-down menu. Propagation profiles contain 

information about your Fixlet server, and are made available by the Fixlet site 
administrator. 



BigFix Development Environment Page 63 
PROPAGATION March 7, 2003 

 © 2003 by BigFix, Inc. 
   

44  In the Local Folder field, type in the pathname, or Browse for the local folder that 
will act as a staging area for the final propagation to the server. 

55  Select the Minimum Approval Level to filter the Fixlet content to be propagated. For 
example, if you set the minimum approval level to 4, all digests, Fixlet messages, and 
all related files that have been approved to level 4 or above would be propagated. 
Content approved from levels 0 through 3 would be ignored, and not moved to the 
local staging area.  

66  The Include Fixlets at Level boxes will be automatically checked, according to your 
approval setting, to indicate which levels will be propagated. These boxes apply only 
to Fixlet messages, not other content, like graphics or templates. In general, you 
should accept these levels. However, there may be instances where you wish to specify 
that only certain levels of Fixlet messages should be propagated. This can be very 
useful for creating test sites. For instance you might want to create a site that only 
includes Fixlet messages at approval level 2 -- ready for testing but not yet ready for 
release.  

77  If propagating to a propagation server, as opposed to a local site, you will need to 
supply your publishing credentials to authorize the propagation. Fixlet sites may need 
a Publisher Private Key, a Publisher Certificate and a Site Certificate. If this data is not 
properly filled out, you will need to click the button labeled Edit Credentials. 
 

 
 
Browse to your site credentials, and click OK. 

88  Press the Propagate button. The Message Log window provides a running account of 
each file as it is propagated. If any error messages show up, you can fix the problem 
and click the propagate button again. 

99  If any Fixlet site elements have previously been approved to the selected minimum 
approval level or higher but are currently at a lower approval level, the Propagation 
Status dialog will appear. This window gives you the option of removing Fixlet site 
elements that were previously propagated but are currently undergoing revisions. If an 
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item is checked, the previously propagated version of that item will continue to be 
propagated, even though the current version of the item in the database is below the 
minimum propagation level. If an item is unchecked then it will be pulled from 
propagation and will no longer appear for users who are subscribed to the site. An item 
will initially be checked or unchecked based on the propagation recommendation 
entered when the item was saved or approved. 
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